Nghién ctiu - Ung dung
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@Dai hoc Kinh té Quoc dan

Tém tit:

Bai bdo trinh bay két qud nghién ciru ting dung gidi phdp phat hién, danh gid nhanh, ¢6 hiéu qua
cao vé mirc dg, pham vi bién dong bé mat hién trang phuc vu cong tac lap duw an thiét ké ky thudt —
du toan cdp nhat co so dir liéu su dung anh SPOT 6/7 va CSDL nén dia ly quéc gia nam 2009. Nhom
tac gia chuyén doi dir liéu nén dia Iy dinh dang vector vé dinh dang raster két hop phan loai, gop
nhém, tiép dén sir dung ky thudt phat hién bién dong (change detection) diwa vao ky thudt phan logi
danh da phé dé lgp ma tran bién dong. Quy trinh phdt hién, danh gid bién déng doi twong dia Iy thir
nghiém tai khu vuc xa Hung Tay, huyén Hung Nguyén, tinh Nghé An.

1. Pit van dé

Trong giai doan lap dy an va thiét ké phuc vu
thanh lap va cap nhat co so dir licu nén dia ly
néu qué trinh khao sat bién dong phu thudc hoan
toan vao cong tac ngoai nghiép tai dia phuong sé&
gy tén kém thoi gian va kinh phi. Ngugc 1a1
néu danh gia bién dong chi dua vao cac ngudn
bao cao ndi nghiép hodc giai phap khéng phu
hop thi khi dy an di vao thi cong c6 kha nang
phat sinh khdi luong dién tich do bu so véi thiét
ké. Giai phap xac dinh bién dong cac ddi tugng
bé mit dua trén tu liéu anh méi va co s¢ dit liéu
dla 1y thoi ky trude trude va phuong phap Xu ly
vién tham co thé giai quyét mot phan cac van dé
néu trén.

Trong thoi gian t6i, Cuc Vién tham Qudc gia
s& cung cdp anh vién tham do phan giai cao
SPOT 6/7. Véi d6 phan giai khong gian ddi vai
céc kénh Panchromatic 13 1,5 m, t6 hop mau 1,5
m (Bang 1), cac kénh da ph6 8 m, khi két hop co
thé xu 1y ting cudng 1én 6 m (Atrium, 2013),
anh vién tham SPOT 6 dam bao do chinh xac
cho xac dinh bién dong va cap nhat thong tin
hién trang bé mat.

Bdng 1: Bang thong sé chinh ciia
thiét bi quang hoc

2 dng kinh thidn vin Korsch,

do mo éng kinh 200 mm

PAN: 28,000 pixels

MS: 4 x 7000 pixels
Panchromatic: 0.450 - 0,745 um
Blue: 0,450 - 0,520 pm

Green: 0,530 - 0,590 um

Red: 0,625 - 0,695 um

Near Infrared: 0,760 - 0,890 um
60 km tai diém thién dé

12 biats

Hé théng quang
hoce

Mang dién tir

Phén giai phd

b rong dai quét
50 bits

Cong tac danh gia bién dong st dung anh da
thoi gian hodc sir dung anh két hop dit liéu GIS
da duoc tmg dung nhiéu trén thé gisi va Viét
Nam (JES, 2014; Phan Kiéu Diém, 2013). Tuy
nhién, quy trinh st dung co so dir li€u tir dinh
dang vector sang dinh dang raster dé so sanh
bién dong voi anh SPOT chua dugc nghién ctru
tai Viét Nam. Do d6, nghién ctru nay gdp phan
b6 sung thém phuong phap méi vao dénh gia
bién dong.

2. Muc tiéu va phuwong phap nghién ciru
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Muc tiéu nghién ctru 1a dé xuat giai phap phat
hién, danh gia, xac dinh mtc d9, pham vi bién
dong cac nhom d6i tuong dia 1y va xay dung quy
trinh phuc vu cong tac 1ap du an, lap thiét ké k¥
thuat - du toan.

Tai li€u st dung trong nghién ctu:

+ Sir dung anh SPOT 6/7 tai thoi diém nghién
clru.

+ Co so dir liéu nén dia 1y qudc gia hién co
thoi gian trudc.

Néu chong xép cac nhom dir liéu cua CSDL
nén dia 1y cii 1én trén nén binh d6 anh vé tinh
moi dé ra soat, phat hién cac dbi tugng dia 1y bi
bién dong bang truc quan va cac thao tac thu
cong s& mat rat nhiéu thoi gian, cong stc, phu
thuoc vao nang luc, kinh nghiém cta cac tac
nghi¢p vién nén kho dam bao nang cao nadng
sut, hiéu qua cong viéc (Umut Gunes Sefercik,
2008)

Trude van dé thyc tién nhu trén, nghién ctru
dé xuét giai phap phat hién mirc do, pham vi bién
dong phu hop véi diéu kién dit liéu hién nay do
khong co tu liéu anh vé tinh ¢ thoi diém trude va
két hop k¥ thuat phan loai anh vé tinh, k¥ thuat
phan tich bién dong, trong do dit lidu dau vao la
CSDL nén dia Iy quéc gia hién c6 va tu liéu anh
vé tinh ¢ thoi diém hién thoi.

3. Xay dung quy trinh phat hién, danh gia,
xac dinh mirc d§ pham vi bién dong

Quy trinh phat hién, danh gia, xac dinh mirc
dd pham vi bién dong dugc trinh bay tai hinh 1
dudi day.

Mo td cdac budc chinh quy trinh:

1. Ranh gioi khu vuc nghién ciru

La duong dia gidi khu vuc nghién ctru. Dung
lam duong bao dé cat phan CSDL va anh SPOT
6/7 da pho.

2. CSDL khu vuc nghién ciru

C¢ s¢ dir liéu khu vuc nghién ctru dinh dang
mdb, cac doi tugng dia ly phan theo cac nhom
16p theo céc feature dataset su dung trong phan

mém ArcGIS.

Trong nghién ctru nay chi yéu phuc vu cho
cong tac danh gia bién dong lap thiét ké tap trung
vao mot s6 nhém 16p nén nhoém 16p dia hinh,
nhom bién gidi - dia gidi, cac ddi tuong dang
diém, text, label (Point, Anonation) khong duoc
xét dén.

Cét di it theo ranh
gidi khu vie nghién cio

v v

CEDL khu vwe Ann vé tinh Sl_:'OT
nzhién cin 6. 7 da phd
Bién tdp, gdp cic nhom Phan leai anh

dci twong dia Iy

I !

Convert dif lidn Asnh phin loai bede ddu
sang Raster l

Gip, bign thp cac nhém 5
trong dwoc phin loai

Y
Anh phan loai Anh &t qua phén loai
(Thii ki 1) (Thivi ky 2)
Théng k2 phat higa

bién ddns

Hinh 1: Qui trinh phat hién, danh gia, xac dinh
mirc do pham vi biéen dong

3. Bién tdp gop cac nhém doi twong

Trude hét can phai xay dung cac 16p phan
loai. Céc 16p phan loai can dugc dinh rd rang vé
mat chi tiéu. Céc chi ti€u nay dugc lya chon dya
vao dic thi cta tu liéu vién thim dang sir dung
va tu liéu CSDL trong cac nhom doi twong dia
ly.

C6 7 16p lya chon bao gom:

- Dan cu (Nghia dia, khu dan cu,...)

- Pat tréng (Dat trong, duong dat, cat, doi
troc,...)

- Giao thong (Cong trinh giao thong, duong
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nhua, duong bé tong,...)

- Khai thac (Khai thac, Cong trinh cong
nghiép,...)

- Khu cay trong nong nghiép (Cay lua, cay
lvong thuc khac, cdy rau, khu trong cay nong
nghiép)

- Nudc mat (khu nuoi tréng thuy san, ao, ho,
dam, pha, song suodi, kénh, muong,...)

- Rung (rung céy bui, rung cay 1a kim, cay la
rong,...)
4. Chuyén doi dir liéu sang dang raster

+ Trong ArcToolbox chon c¢ong cu
Conversion Tools => To Raster => Feature to
Raster dé chuyén cac ddi twong dia 1y sang dang
raster.

+ Chon d9 kich thudc pixel cua file raster dau
ra la 6m (twong Ung véi kich thude pixel cta
binh d6 anh SPOT); Chon dinh dang file 1a
GeoTIFF; Pit tén file: gom tén file gbc cong
thém thanh phin MDB dé dé dang phan biét
dugc day 1a file anh cua CSDL nén dia 1y qubc
gia tuong Ung;

5. Anh phan logi (thoi ky 1)

Sau budc 4 khi chuyén doi tir dit liéu vector
sang dir li¢u raster ta dugc anh phan loai thoi ky
1. DBat tén file vdi phan mo rong la _TK1

6. Phan loai dnh

+ Tai nhiing khu vuc khong c6 mdt thong tin
nao vé ddi twong can phén loai st dung k¥ thuat
phan loai khéng giam dinh. Phan loai khong
giam dinh chi su dung thuan tay thong tin anh.
Trinh ty x{r Iy ¢6 thé tom tit nhu sau:

- Cac pixel trén anh dau tién dugc gop thanh
nhom c6 dac trung pho tuong d6i dong nhat
bang k¥ that ghép lop.

- Cac nhém 16p nhu vay dugc st dung dé tinh
cac tham s6 thong ké cho qua trinh phan loai tiép
theo.

- Viée xé4c dinh cac tham sb thong ké tép mau
phu thude cu thé vao cac phuong phap phan loai

s& duogc sir dung. Tuy nhién phan 16n cac 16p
thuat toan phan loai déu st dung cac tham )
nhu nhu gia tri trung binh t&p mau, ma tran,
phuong sai.

- Phan loai da phd dé tach cac thong tin can
thiét phuc vu cho viéc theo doi cac ddi tuong hay
lap ban dd chuyén dé 1a khau then chét ciia viée
khai thac tu liéu vién tham.

+ St dung cong cu Unsupervised
Classification trén phan mém ERDAS hodc phan
mém ENVI (Phén loai khong giam dinh) dé phan
loai cac nhoém ddi tuong dia ly:

+ Anh vé tinh dugc str dung 13 binh d6 anh da
pho dang so, gom cac kénh Red, Green, Blue va
NIR;

+ Pit tén cac nhom 16p ddi tuong dia 1y s&
dugc phan loai theo tén cac nhom doi tugng dia
ly cua CSDL;

7. Anh phén logi buéc ddu

Lua chon kénh phd dé téng hop mau 1a mot
cong viéc quan trong quyéet dinh chat luong
thong tin cuia két qua tong hop mau.

Viéc lya chon thong tin kénh phé dugc xac
dinh trén co so sau:

- Pac tinh phan xa phd cta cac ddi tugng can
giai doan

- Nhiém vy giai doan

- Yéu cau d6i v6i luc phan giai

- Bic diém cua ving can tong hop mau...

Két qua bude dau cua phan loai khong gidm
dinh la file raster (kich thudc plxel la 6m), trong
d6 nhom pixel duge thé hién bang cac mau sic
khac nhau;

8. Gop, bién tdp cdac nhom doi tuwong duoc
phan logi

Dé chon kénh phd mang tinh thong tin cao
can phéan loai nhom ddi tuwgng chinh can giai
doan. Trén co sé cac kénh phd mang thong tin ta
chon ra kénh chinh va kénh phu dé tong hop
mau.
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+ Str dung binh dd anh vé tinh (4nh mau tu
nhién, dang sb6) dé xem xét cac nhom pixel da
phan loai thuéc nhom 16p nao dé gan tén 16p ddi
tuong dia 1y cho tirng nhom;

+ C6 thé xut hién mot s6 nhoém pixel c6 mau
khac nhau nhung ban chit chiing thudc vé ciing
mot 16p d6i twong dia 1y thi phai tién hanh gop
lai (combine) thanh mét 16p duy nhit;

9. Anh két qua phan logi (Thoi ky 2)

+ Két qua phan loai khong giam dinh 1a file
raster sau khi da gdp dugc cac nhém pixel c6 cac
mau tuong ung voi cdc nhom doi tuong dia ly;

+ Tén file duoc léy theo khu vuc cong thém
phan m¢ rong TK2 dé dé dang phan biét duoc
day la file anh phan loai cua binh d6 anh;

10. Théng ké phat hién bién déng doi twong
dia Iy (Change Detection Statistics)

+ Str dung cong cu Basic Tools => Change
Detection => Change Dectection Statistics;

+ Vi Initial State (hién trang ban dau): chon
file raster cuia CSDL (* TK1.TIF);

+ Véi Final State (hién trang cudi): chon file
raster tr phan loai anh (* TK2.TIF);

+ Céac két qua cua thong ké phat hién bién
dong chon la Area (c6 3 tuy chon Pixels (SO
luong pixel khac biét) hodc Percent (SO phan

- 8- %0

Téng

tram khac biét) hodc Area (dién tich khac biét));

+ Dt tén file anh danh dau phan logi két qua
dau ra (Output Classification Mask Images) voi
kich thudc pixel la 6 m;

+ Két qua nhan duoc 1a anh danh dau phdn
logi két qua dau ra kém theo s0 li€u thong ké
phat hién bién dong cua cac nhom doi tuong dia
ly. Két qua nay giup xac dinh nhanh mirc d6 bién
dong cua CSDL dén thoi diém chup anh, qua do
dinh hudéng cong tac Ra sodt, cdp nhdt ngi
nghiép doi twong dia ly va chi dan budc Diéu tra
bo sung ngoai nghiép ti€p theo.

11. Cdc két qua

+ Bang biéu dién tich ting nhom dbi tuong
bien dong

+ Ban d hién thi két qua dién tich ddi tugng
bién dong

4. Thye nghiém

4.1. Bién tdp, gop cdc nhém doi twong dia 1y

Vi chi tap trung vao ddi twong dang vung
(polygon) nén nhém phu bé mat dam bao du céac
l6p doi tuwong. Sau khi x4c dinh gom cac doi
tuong theo 7 nhém 16p, trén feature Tong hop
tao thém truong “GomNhom” (kiéu dir li¢u text)
gan ting doi tuong voi tén theo cac nhom liét ké
trén trong bang thudc tinh. (Xem hinh 2)

(= | 4

Tén | Loai phi be mar |

GomNhom |

Cay ia kim
Cay o kim |

o4

Téng hep

doiluoig |

Hinh 2: Bdng thudc tinh 16p Tong hop véi truong GomNhom
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4.2. Chuyén doi dir liéu sang dang raster timg nhém ddi twong bién dong trinh bay tai

Str dung cong cu Feature to Raster trong phan bang 2 dui day. (Xem bang 2, hinh 6)

mém ArcGis

Két qua sau khi thuc hién bude chuyén doi:

- - Hinh 5: Anh Spot cdt theo ranh gii
Hinh 3: CSDL thé hién bang bo ky hiéu khu vuc nghién ciru
1:10.000

BAN DO BIEN DONG XA HUNG TAY, HUYEN HU'NG NGUYEN TINH NGHE AN

:
>
‘_

Hinh 4: CSDL duwoc chuyén sang
dinh dang Raster

4.3. Anh vé tinh SPOT 6,7 da phé

Thu thap tir TKKT-DT “B6 sung, cip nhét co
s& dit lidu nén dia 1y cac ty 1& khu vyuc 10 tinh:
Thai Binh, Ha Nam, Nam Dinh, Ninh Binh,
Thanh Hoéa, Ngh¢ An, HE‘I’ Tinh, Quang Binh, Ghi chu
Quang Tri, Thtra Thién Hue” thugc Cuc Po dac, | ———
Ban dd va Thong tin dia Iy Viét Nam. (Xem {0 s w10 i stmg
hinh 5) - '

4.4. Thong ké phat hién bién dong doi twong — Hinh 6: Ban do hién thi két qua dién tich déi
dia ly tuwong bien dong

Két qua ctia qua trinh 13 bang biéu dién tich

TAP CHi KHOA HOC PO DAC VA BAN DO SO 47-3/2021 52



Nghién ctiu - Ung dung

Bdng 2: Bang ma trdn bién dong

Tho ky 2 . ; .
. - Khai théac, | Khu cdy
(Tir anh Spot) : . e D N
. Pat G1ao cong trinh | trong Niroc .
Dancw | . L . R Rimg
Théi ki 1 trong | théng | cong nong mat -
101 ky
nghié nghié
(CSDL) ghiep ghiep
Dén ce 23175 | 1.5 10,98 | 0,51 471 0,69 |541
Dit tréng 2011 | 4,87 |1,78 142 3,03 062 |067
Giao théng 074 |0 5.67 0,02 0,05 0,15 |0
Khai thac, cong trinh __ _
) s 20,57 | 029 |057 21,91 3,47 336 |4.06
cong nghiép
Khu ciy tréng néng .
. = T 184,33 | 47,44 | 41,01 126,46 697 67 19.64 | 10,48
nghidp ; ) ;
Nude mat 1952 |031 |1,56 1,91 2.4 327 |0
Rimg 2291 8.7 0,49 65,33 6,34 2,09 1992

Nhin vao sé liéu trén bang ma tran bién dong
(Bang 2) thiy rang giai doan 2009-2019 khu vuc
xa Hung Tay, huyén Hung Nguyén, tinh Nghé
An c¢6 su bién dong rat 16n vé dién tich cua cac
dbi twong dia 1y. Dién tich bién dong chiém
(645,83/1839,6)*100% = 35% dién tich cia toan
xa.

5. Két luan

Viée sir dung phuong phap chuyén ddi co so
dir liéu dinh dang vector sang dinh dang raster so
sanh cung anh SPOT dé danh gia bién dong gop
phan b6 sung thém cic phuong phap danh gia
bién dong.

Giai phap st dung cac ngudn tu lidu anh
SPOT 6 nam 2019 sau khi xt 1y phan loai va
gom nhom va CSDL nén dia ly quoc gia trude do
tiét kiém chi phi, thoi gian dam bdo cac yéu cau
ky thuat vé xac dinh bién dong bé mat phuc vu
1ap thiét ke dy toan.

Quy trinh phat hién va danh gia dua ra duoc
két qua nhanh, chinh xac dam bao phuc vu cho
giai doan thiét ké k¥ thuat dy toan.Q
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